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iIntroduction
Welcome! This Step by Step book has been designed so you can read it from the 
beginning to learn about Microsoft Visio 2016 and then build your skills as you learn 
to perform increasingly specialized procedures. Or, if you prefer, you can jump in 
wherever you need ready guidance for performing tasks. The how-to steps are deliv-
ered crisply and concisely—just the facts. You’ll also find informative, full-color graphics 
that support the instructional content.

Who this book is for
Microsoft Visio 2016 Step by Step is designed for use as a learning and reference 
resource by home and business users of Microsoft Office programs who want to use 
Visio to create a variety of diagrams for business and personal use. The content of the 
book is designed to be useful for people who have previously used earlier versions of 
Visio and for people who are discovering Visio for the first time.

The Step by Step approach
The book’s coverage is divided into parts representing general Visio skill sets. Each 
part is divided into chapters representing skill set areas, and each chapter is divided 
into topics that group related skills. Each topic includes expository information fol-
lowed by generic procedures. At the end of the chapter, you’ll find a series of practice 
tasks you can complete on your own by using the skills taught in the chapter. You can 
use the practice files that are available from this book’s website to work through the 
practice tasks, or you can use your own files.
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Adapt procedure steps
This book contains many images of user interface elements (such as the ribbon and 
the app windows) that you’ll work with while performing tasks in Visio on a Windows 
computer. Depending on your screen resolution or app window width, the Visio 
ribbon on your screen might look different from that shown in this book. (If you turn 
on Touch mode, the ribbon displays significantly fewer commands than in Mouse 
mode.) As a result, procedural instructions that involve the ribbon might require a 
little adaptation.

Simple procedural instructions use this format:

1.	 On the Insert tab, in the Illustrations group, click the Pictures button.

If the command is in a list, our instructions use this format:

1.	 On the Home tab, in the Editing group, click the Layers arrow and then, in the 
Layers list, click Layer Properties.

If differences between your display settings and ours cause a button to appear differ-
ently on your screen than it does in this book, you can easily adapt the steps to locate 
the command. First click the specified tab, and then locate the specified group. If a 
group has been collapsed into a group list or under a group button, click the list or 
button to display the group’s commands. If you can’t immediately identify the button 
you want, point to likely candidates to display their names in ScreenTips.

Multistep procedural instructions use this format:

1.	 Display the Backstage view.

2.	 In the left pane of the Backstage view, click New.

3.	 On the New page, click Categories, click the Business thumbnail, and then 
double-click the Organization Chart template.

Introduction
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On subsequent instances of instructions that require you to follow the same process, 
the instructions might be simplified in this format because the working location has 
already been established:

1.	  On the New page of the Backstage view, click Categories, click the Business 
thumbnail, and then double-click the Organization Chart template.

The instructions in this book assume that you’re interacting with on-screen elements 
on your computer by clicking (with a mouse, touchpad, or other hardware device). If 
you’re using a different method—for example, if your computer has a touchscreen 
interface and you’re tapping the screen (with your finger or a stylus)—substitute the 
applicable tapping action when you interact with a user interface element. 

Instructions in this book refer to Visio user interface elements that you click or tap on 
the screen as buttons, and to physical buttons that you press on a keyboard as keys, to 
conform to the standard terminology used in documentation for these products.

When the instructions tell you to enter information, you can do so by typing on an 
external keyboard, tapping an on-screen keyboard, or even speaking aloud, depend-
ing on your computer setup and your personal preferences.

Introduction
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Download the practice files
Before you can complete the practice tasks in this book, you need to download the 
book’s practice files to your computer from http://aka.ms/Visio2016sbs/downloads. 
Follow the instructions on the webpage.

IMPORTANT  Visio 2016 is not available from the book’s website. You should install that 
app before working through the procedures and practice tasks in this book.

You can open the files that are supplied for the practice tasks and save the finished 
versions of each file. If you later want to repeat practice tasks, you can download the 
original practice files again.

The following table lists the practice files for this book.

Chapter Folder File

1: Get started with Visio 2016 Visio2016SBS\Ch01 ExploreDrawing.vsdx

GetStarted.vsdx

ManageShapesWindow.vsdx

PanAndZoom.vsdx

2: Create diagrams Visio2016SBS\Ch02 PositionShapes.vsdx

ResizeShapes.vsdx

SelectShapes.vsdx

UseAutoAddAutoDelete.vsdx

UseAutoConnect.vsdx

UseDynamicConnectors.vsdx

UseLines.vsdx

3: Manage text, shapes, and 
pages

None None

4: Create business process 
diagrams

Visio2016SBS\Ch04 CreateSubprocesses.vsdx

5: Create organization charts Visio2016SBS\Ch05 AlterLayout.vsdx

OrgChartData.xlsx

Photos folder with 27 images of 
people

xvi
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Chapter Folder File

6: Add style, color, and themes Visio2016SBS\Ch06 AlignSpaceShapes.vsdx

7: Create network and 
datacenter diagrams

Visio2016SBS\Ch07 ChangeDrawingScale.vsdx

CreateRacks.vsdx

8: Work with shape data Visio2016SBS\Ch08 CreateModifyReports.vsdx

EditShapeData.vsdx

InsertFields.vsdx

ModifyDataAttributes.vsdx

RunReports.vsdx

Vegetation Report.vrd

9: Visualize your data Visio2016SBS\Ch09 CreateDataGraphics.vsdx

RiskManagementTaskMap.pdf

10: Link to external data Visio2016SBS\Ch10 Photos\Oleg Anashkin.jpg

OrgChartData.xlsx

OrgChartData_Supplement1.xlsx

UseQuickImport.vsdx

UseCustomImport.vsdx

11: Add and use hyperlinks Visio2016SBS\Ch11 EnhanceDiagrams.vsdx

FollowHyperlinks.vsdx

Human Resources Policy 
Manual.docx

12: Print, reuse, and share 
diagrams

Visio2016SBS\Ch12 CreateGraphics.vsdx

CreateTemplates.vsdx

PreviewDrawings.vsdx

PublishToWeb.vsdx

SaveInFormats.vsdx

13: Add structure to your 
diagrams

Visio2016SBS\Ch13 AnnotateShapes.vsdx

OrganizeByContainers.vsdx

OrganizeByLists.vsdx

xvii
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Chapter Folder File

14: Validate diagrams Visio2016SBS\Ch14 ReuseRules.vsd

RuleSets--BPMN 2.0.html

RuleSets--Cross-Functional 
Flowchart.html

RuleSets--Flowchart.html

RuleSets--SharePoint 2010 
Workflow.html

RuleSets--SharePoint 2016 
Workflow.html

ValidateBPMN.vsdx

ValidateFlowcharts.vsdx

ValidateSwimlanes.vsdx

15: Collaborate and publish 
diagrams

None None

Appendix A: Look behind the 
curtain

Visio2016SBS\AppA ViewShapeSheet.vsdx

Appendix B: Keyboard 
shortcuts for Visio

None None

Ebook edition
If you're reading the ebook edition of this book, you can do the following:

■■ Search the full text

■■ Print

■■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at 
http://aka.ms/Visio2016sbs/details.
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Get support and give feedback
This topic provides information about getting help with this book and contacting us 
to provide feedback or report errors.

Errata and support
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. If you discover an error, please submit it to us at http://aka.ms/Visio2016sbs 
/errata.

If you need to contact the Microsoft Press Support team, please send an email message 
to mspinput@microsoft.com.

For help with Microsoft software and hardware, go to http://support.microsoft.com.

We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book at http://aka.ms/tellpress.

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at http://twitter.com 
/MicrosoftPress.

xix
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1Get started 
with Visio 2016

In this chapter
■■ Identify the editions of 

Visio 2016

■■ Discover new features in 
Visio 2016

■■ Get started in Visio 2016

■■ Explore the Backstage view

■■ Understand tool tabs and 
add-in tabs

■■ Begin quickly by using starter 
diagrams

■■ Explore the drawing window

■■ Manage the Shapes window

■■ Pan and zoom in the drawing 
window

Practice files
For this chapter, use the practice 
files from the Visio2016SBS\Ch01 
folder. For practice file download 
instructions, see the introduction.

Microsoft Visio is the premiere application for creating 
business diagrams of all types, ranging from flowcharts, 
process maps and organization charts, to datacenter 
layouts, floor plans, and brainstorming diagrams.

Much more than just a diagramming app, Visio makes it 
easy to connect diagrams to live data sources, and then 
publish the results to Microsoft SharePoint to create 
near-real-time dashboards. On top of all that, you can 
use Visio to create a pattern for a quilt or to design a new 
kitchen for your house!

Visio 2016 includes many new features, including one 
that eliminates the curse of the blank page when you’re 
starting a new diagram. Between that feature and the 
techniques you will discover in this chapter, you’ll be off 
to a running start with Visio.

This chapter guides you through procedures related to 
getting started in Visio 2016, exploring the Backstage 
view, beginning quickly by using starter diagrams, 
exploring the drawing window, managing the Shapes 
window, and panning and zooming in the drawing 
window.
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Identify the editions of Visio 2016
Visio 2016 is available in three editions. The first two editions use the traditional desk-
top purchase and installation model and mirror the two editions that were offered in 
most prior Visio releases. The third edition is part of the Microsoft Office 365 suite of 
subscription-based applications.

■■ Visio Standard 2016  This is the starter edition of Visio. It provides significant 
capability for creating business diagrams and includes 26 templates that are 
divided into six categories.

■■ Visio Professional 2016  This edition expands on the Standard edition by 
offering more than four dozen additional templates, for a total of 76 across 
eight categories. In addition, Visio Pro offers the ability to link diagrams to a 
wide variety of data sources, and includes a diagram validation capability that 
is especially well suited for the expanded set of business process diagrams it 
supports.

■■ Visio Pro for Office 365  This edition of Visio provides the identical features 
and templates as Visio Professional 2016. The key differences in this edition are 
in packaging and delivery. As part of Office 365, there is no up-front license fee. 
Instead, you pay a monthly subscription fee and can install the software on up 
to five computers.

Discover new features in Visio 2016
Visio 2016 is sleek-looking, colorful, connected, portable, collaborative, and helps 
protect your document content.

The following list describes key new capabilities of Visio 2016:

■■ Starter diagrams  Creating a diagram from a blank page can be daunting, 
especially if you’re working with a new diagram type. Visio 2016 helps you get 
started more quickly by providing dozens of starter diagrams.

SEE ALSO  For more information about starter diagrams, see “Begin quickly by 
using starter diagrams” later in this chapter. 

Chapter 1: Get started with Visio 2016
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1
■■ Modernized shapes  Dozens of Visio shapes received makeovers for Visio 2016. 

The updated shapes look modern, as shown in the comparison of Visio 2013 
furniture shapes, on the left in Figure 1-1, with the equivalent shapes from 
Visio 2016 on the right. In addition to changes in appearance, some new shapes 
exhibit smart behavior. For example, if you increase the length or width of the 
Visio 2016 table in Figure 1-1, additional chairs appear!

Figure 1-1  Many Visio 2016 shapes have a fresh, new look

You will find updated masters in stencils associated with templates for office 
layouts, site plans, floor plans, home plans, and electrical diagrams.

■■ Tell Me  The Microsoft Office Tell Me feature makes finding any one of the 800 
commands in Visio as easy as entering a word or phrase. Tell Visio what you 
want to do, and it responds with a list of executable commands.

Some commands in the response list might be dimmed (unavailable) because 
the Tell Me feature is context-aware. For example, if you start entering the word 
container when a container is not selected, most commands are unavailable, as 
shown on the left in Figure 1-2. However, if a container is selected, additional 
commands are available, as shown on the right.

Figure 1-2  Tell Me provides instant access to relevant commands

Discover new features in Visio 2016
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■■ Information Rights Management (IRM)  In Visio 2016, you can assign access 
rights so only authorized people can read or modify your diagram.

SEE ALSO  For more information about IRM, see the sidebar “What is Informa-
tion Rights Management?” in Chapter 12, “Print, reuse, and share diagrams.” 

■■ High-resolution device support  All buttons, menus, and features of Visio 2016 
now operate properly on high-resolution displays like the Microsoft Surface.

■■ Support for standards  Three types of diagrams included with Visio Professional 
2016 have been updated to comply with the latest versions of the relevant inter-
national standards.

●● The Basic Electrical template in the Engineering template group complies 
with standards from the Institute for Electrical and Electronic Engineers 
(IEEE).

●● The BPMN Diagram template (available only in Visio Professional) in the 
Flowchart template group conforms to Business Process Model and Notation 
(BPMN) 2.0.

SEE ALSO  For more information about BPMN, see Chapter 4, “Create 
business process diagrams.”

●● The six UML templates in the Software and Database template group 
comply with Unified Modeling Language (UML) 2.4.

■■ Quick Import  The new Quick Import wizard (available only in Visio Professional) 
links a diagram to external data, links data to individual shapes, and then applies 
a data graphic to each shape—all in a single, seamless operation.

SEE ALSO  For more information about Quick Import, see Chapter 10, “Link to 
external data.”

Chapter 1: Get started with Visio 2016
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1Get started in Visio 2016
The Visio Start screen is shown in Figure 1-3. In addition to a list of recently opened 
diagrams, the Start screen displays thumbnails of available templates.

TIP  The New page of the Backstage view, which is shown in Figure 1-12 in the following 
topic, presents the same template options as the Start screen. When you first start Visio, 

you can create a diagram from the Start screen. If Visio is already running, you can create one 
from the New page.

Figure 1-3  Featured templates appear by default, but you can view template categories

IMPORTANT  The Start screen always displays featured templates first. It’s easy to 
overlook the Categories button that presents a more traditional view of templates 

organized into logical groups.

Get started in Visio 2016
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Understand shapes, masters, stencils, and 
templates
Before you explore the rest of Visio, it’s helpful to understand a number of 
commonly used terms:

■■ Shape  An object on a Visio drawing page.

A shape can be very simple, such as a line, a polygon, or an image. A 
shape can also be a sophisticated object that changes appearance or 
behavior as data values change, as its position on the page changes, or 
as properties of another shape change—the possibilities are endless.

Usually, you create shapes by dragging a master from a stencil to the 
drawing page; however, you can create shapes in other ways. You will 
learn more about shapes in Chapter 2, “Create diagrams,” and through-
out this book.

■■ Master  An object in a Visio stencil.

Most people who create diagrams by using Visio use either the masters 
that ship with Visio or masters that they download from the Internet. 
You can also create your own masters, and you’ll find enough informa-
tion to get started in Appendix A, “Look behind the curtain.” 

■■ Stencil  A collection of masters.

Visio includes both metric and US unit versions of more than two 
hundred stencils. Each stencil contains several, or several dozen, related 
masters. Examples include stencils named Furniture, Transportation 
Shapes, Workflow Shapes, Network Locations, and Timeline Shapes. 
Appendix A, “Look behind the curtain,” describes how to create a 
custom stencil.

■■ Template  A Visio document that includes one or more drawing pages 
with preset dimensions and measurement units.

A template generally contains one or more stencils, and it might 
include background pages, themes, shapes, or text. A template can 
include special software that only operates in that template.

Chapter 1: Get started with Visio 2016
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1■■ Workspace  A collection of Visio windows and window settings.

At minimum, the workspace consists of the drawing window and the 
zoom settings for the pages in the drawing. Frequently, it includes a 
Shapes window containing one or more stencils. The workspace can 
also include the Shape Data, Size & Position, and Pan & Zoom windows, 
in addition to template-specific windows.

Unless you change the default action, Visio saves the on-screen work-
space whenever you save a document. Consequently, the next time you 
open the document, Visio restores the workspace.

TIP  Despite the distinction made in this list between a master and a shape, 
many people refer to an object in a stencil as a shape. Indeed, when you think 
about it, the window that displays stencils is called the Shapes window! Conse-
quently, unless the distinction is important in a specific context, the text in this 
book will usually refer to objects in stencils and on the drawing page the same 
way—as shapes.

To begin a diagram based on an existing template, you can do any of the following:

■■ Search online for templates by entering keywords or by clicking any word in the 
Suggested Searches list.

IMPORTANT  Searching with a keyword will not produce the same result as 
selecting a template category that matches the keyword. For example, clicking 

the Flowchart search term yields some of the same templates that you find in the 
template category named Flowchart. However, it also returns a list of several—or several 
hundred—templates that is likely to include both Visio templates and templates for 
other apps in the Office suite.

■■ Use a template in the Featured section. The presentation of thumbnails in this 
section is dynamic: the templates you use most frequently rise to the top.

TIP  The Blank Drawing template shown in Figure 1-3 opens the drawing page 
but does not open any stencils. 

Get started in Visio 2016
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■■ Use the Categories view to locate templates that are organized into groups. 
Visio Standard displays six categories: Business, Flowchart, General, Maps and 
Floor Plans, Network, and Schedule. Visio Professional adds two categories: 
Engineering, and Software and Database.

At the end of the template categories list is an additional entry called New From Exist-
ing, as shown in Figure 1-4. When you click this thumbnail, you can select any existing 
Visio diagram. Visio then opens a copy of the diagram as a new document and leaves 
the original untouched.

Figure 1-4  The New From Existing button helps protect your diagram

Clicking any template category displays thumbnails for the templates in that category. 
Figure 1-5 shows several of the templates in the Maps And Floor Plans category.

Figure 1-5  Sample template thumbnails

If you click once on a diagram thumbnail, Visio displays information about that tem-
plate, as shown in Figure 1-6. If you double-click a diagram thumbnail, Visio launches 
a new diagram.

Chapter 1: Get started with Visio 2016
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1IMPORTANT  Many Visio templates include starter diagrams that provide additional 
options for creating diagrams. See “Begin quickly by using starter diagrams” later in this 

chapter for more information.

Figure 1-6  The template information panel includes a description of the template

TIP  When you create a new diagram, Visio names it Drawingn, where n is a sequence 
number that is incremented for each new drawing created within one Visio session. 

Closing and restarting Visio always resets the sequence number to 1.

Visio templates are provided in two sets of measurement units:

■■ Metric  Metric drawings are based on paper sizes specified by the International 
Organization for Standardization (ISO); the default size is usually A4. Metric 
templates also include other ISO drawing and paper sizes. All measurements 
are in millimeters or other metric measurement units.

■■ US Units  Diagrams created with US Units use the 8.5-by-11-inch, letter-sized 
paper that is common in the United States and parts of Canada and Mexico. 
Templates created for US Units also include additional drawing and paper sizes 
that are common in those countries/regions. The default measurement units 
are inches and feet.

Depending on your system configuration, you might be offered a choice between the 
two, as shown in Figure 1-6.

Get started in Visio 2016
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SEE ALSO  Microsoft provides a Quick Start guide for Visio 2013 (and other  
Office 2013 apps) at office.microsoft.com/en-us/support/office-2013-quick-start- 

guides-HA103673669.aspx. As of this writing, there is no Visio 2016 guide; however,  
the majority of the Visio 2013 guide is correct for Visio 2016.

To open a recently used diagram

1.	 In the Recent column on the Start screen of the Backstage view, click the name 
of the diagram you want to open.

To open a diagram that is not on the Recent list

1.	 In the Recent column, click Open Other Diagrams.

2.	 On the Open page of the Backstage view, click the location, and then open the 
diagram you want.

To use a Featured template

1.	 If the Featured tab is not already active, click the Featured button above the 
thumbnails on the Start screen.

2.	 Do either of the following:

●● Double-click a template thumbnail.

●● Click the thumbnail for the template you want, and then click the Create 
button.

To use template categories

1.	 If the Categories tab is not already active, click the Categories button above the 
thumbnails on the Start screen.

2.	 Click the thumbnail for the category you want.

3.	 Do either of the following:

●● Double-click a template thumbnail.

●● Click the thumbnail for the template you want, and then click the Create 
button.

Chapter 1: Get started with Visio 2016
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1
To search for a template

1.	 On the Start screen, do either of the following:

●● Enter keywords in the Search for online templates box, and then press the 
Enter key.

●● Click one of the keywords in the Suggested searches list.

To use an existing diagram as a template

1.	 If the Categories tab is not already active, click the Categories button above the 
thumbnails on the Start screen.

2.	 Do either of the following:

●● Double-click the New from existing thumbnail.

●● Click the New from existing thumbnail, and then click the Create button.

3.	 In the New From Existing Drawing dialog box, navigate to, and then open the 
diagram you want.

Explore the Backstage view
The Backstage view is the central location for managing files and setting the options 
that control how Visio 2016 operates. You access the Backstage view by clicking the 
File tab on the left end of the ribbon in the Visio window.

Of the 11 commands in the left pane of the Backstage view, only four—New, Open, 
Account, and Options—are available if you do not have a diagram open. The remain-
ing seven appear when you open a diagram.

TIP  If you are in the Backstage view and have a diagram open, you can return to the 
diagram by clicking the left-pointing arrow in the upper-left corner of the Visio window. 

If you don’t have a diagram open, clicking the arrow will return you to the Start screen.

Most of the commands and accompanying pages in the Backstage view will be famil-
iar if you have used other apps in the Office suite. In this topic, you will explore the 
Backstage view, with an emphasis on features that are unique to Visio.

Explore the Backstage view
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The Info page
When you have a diagram open and click the File tab, Visio presents the Info page 
shown in Figure 1-7.

Figure 1-7  You use the Info page to view and change document attributes

The center section of the page includes five buttons:

■■ Protect Diagram  You will explore this button in the sidebar “What is Informa-
tion Rights Management?” in Chapter 12, “Print, reuse, and share diagrams.”

■■ Remove Personal Information  You will learn about this button in Chapter 12, 
“Print, reuse, and share diagrams.”

■■ Reduce File Size  You can click this button if document size is a major consider-
ation and you want to create a smaller file.

■■ Check Compatibility  This button identifies features in the current diagram that 
are not compatible with previous versions of Visio.

■■ Publish Options  You will learn about the SharePoint publishing settings 
behind this button in Chapter 15, "Collaborate and publish diagrams."

Chapter 1: Get started with Visio 2016
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1
The right side of the page provides information about the open document, along with 
a Properties list that you can use to view and set document attributes. You will work 
with the Properties list in several places in this book, including Chapter 11, “Add and 
use hyperlinks,” and Chapter 12, “Print, reuse, and share diagrams.”

The Info page can contain additional buttons, such as the following:

■■ If you open a document in read-only mode, the Save As button, shown in 
Figure 1-8, will appear at the top of the Info page.

Figure 1-8  Altered read-only documents must be saved as new documents

■■ If you open a file created in Visio 2010 or earlier, it will open in compatibility 
mode, and the Convert button, shown in Figure 1-9, will appear at the top of 
the Info page.

Figure 1-9  You can upgrade older diagrams to the Visio 2016 format

SEE ALSO  For more information about current and former Visio file formats, see 
“Understand the Visio 2016 file formats” in Appendix A, “Look behind the curtain.”

■■ When a document is stored in SharePoint or OneDrive, the Check Out and View 
Version History buttons, shown in Figure 1-10 and Figure 1-11, will appear.

Figure 1-10  You can protect documents from simultaneous edits by other authors

As the description next to the button shown in Figure 1-10 suggests, you use the 
Check Out button to prevent others from making changes to a document you 
are editing. When you click the Check Out button, it is replaced by a Check In 
button that you use to mark the document as available.

Explore the Backstage view
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You use the View Version History button to view and manage the current and 
previous versions of a document.

Figure 1-11  SharePoint can track each time a document is saved

The New page
The New page, the upper part of which appears in Figure 1-12, is very similar to the 
Start screen shown in Figure 1-3 in the preceding topic. On the New page, you have 
access to the same featured templates, template categories, and online template 
search options that were described for the Start screen.

Figure 1-12  The New page shows both featured and categorized templates

IMPORTANT  The New page always displays featured templates first. It’s easy to 
overlook the Categories button that presents a more traditional view of templates 

organized into logical groups. 

Chapter 1: Get started with Visio 2016
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1The Open page
As it does throughout the Microsoft Office suite, the Open page, shown in Figure 1-13, 
displays a list of both online and local locations where documents can be stored. You 
can click any location in the left column to see recently used diagrams stored in that 
location. You can also add more online locations to the list, or browse to locate the 
diagram you want.

Figure 1-13  Opening online documents is as easy as opening local documents

The Save command
Clicking Save for an unsaved diagram displays the Save As page that is described in 
the following topic. Clicking Save for a previously saved diagram saves the changes.

Explore the Backstage view
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The Save As page
On the Save As page, shown in Figure 1-14, you can choose a local or online location 
and then select a recent folder or click the Browse button to navigate to the location 
you want.

SEE ALSO  For information about storing Visio diagrams in other formats, see  
Chapter 12, “Print, reuse, and share diagrams” and Chapter 15, “Collaborate and  

publish diagrams.”

Figure 1-14  You can save locally or to OneDrive and SharePoint sites

The Print page
The Print page provides a print preview and printing options. You will explore print 
options in Chapter 12, “Print, reuse, and share diagrams.”

The Share page
You can share your diagram two ways by using the Share page.

You can click Share With People to send people a link to your diagram via email. Your 
diagram must be stored in SharePoint or OneDrive to use the share function. If it is 
not, you will be asked to save it in one of those locations first, as shown in Figure 1-15.

Chapter 1: Get started with Visio 2016
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1

Figure 1-15  Sharing diagrams with other people requires two steps

After the diagram is available online, you can use the form shown in Figure 1-16 to 
send links to one or more people.

Figure 1-16  You can enter one or more email addresses to share a diagram

You can click the Email button to share your diagram using any of the options listed 
on the right side of the page shown in Figure 1-17.

Explore the Backstage view

19



Figure 1-17  One option for sharing by email automatically creates a PDF of your diagram

TIP  Send A Link is available only if your diagram is stored online or in a shared folder. 

The Export page
You can use the Export page to create a PDF or XPS document and to save in a variety 
of other file formats. You will explore other file formats in Chapter 12, “Print, reuse, 
and share diagrams” and Chapter 15, "Collaborate and publish diagrams."

The Close command
Clicking Close closes the active diagram but does not exit Visio.

The Account page
The Account page, shown in Figure 1-18, summarizes information about the Microsoft 
Account that you have linked to Visio. You can click the links in the User Information 
area to change your Microsoft Account details and to switch to another Microsoft 
Account if you have more than one.

The same area provides lists you can use to alter the Office Background and Office 
Theme used for Visio and all other Office applications.
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In the Connected Services area is a list of OneDrive and SharePoint sites to which you 
are currently connected. You can click the Add A Service button to link to additional 
OneDrive and SharePoint sites.

Figure 1-18  Both user profile and application-level settings are on the Account page

Clicking the About Visio button in the Product Information area opens the About 
Microsoft Visio dialog box (see Figure 1-19), which displays version information and 
your product ID.

TIP  The About Microsoft Visio dialog box does not indicate whether you are running 
Visio Standard or Visio Professional; that information is located below the Product 

Activated heading in the Product Information area.

Figure 1-19  The About Microsoft Visio dialog box displays important information

Explore the Backstage view
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The Visio Options dialog box
The Options button opens the Visio Options dialog box, which contains dozens of set-
tings you can use to customize the operation of Visio. Many people use Visio without 
ever needing to change any of these options, but it’s a good idea to examine the 
option categories shown in Figure 1-20 for potential future use.

Figure 1-20  There are dozens of ways to customize Visio

You can use the options in the Visio Options dialog box to perform many actions, a 
few of which are mentioned in the following list:

■■ General  Enter your user name and initials, and set various global options, 
including Live Preview and color choices for all Office apps.

■■ Proofing  Set autocorrect, spelling, and grammar options.

■■ Save  Enable AutoRecover, set the default Visio save format from among three 
choices (Visio Document, Visio Macro-Enabled Document, and Visio 2003-2010 
Document), and set a personal templates location.

■■ Language  Set editing, display, help, and ScreenTip language parameters.

■■ Advanced  Set dozens of options in five categories: Editing, Display, Save/Open, 
Shape Search, and General.
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■■ Customize Ribbon  Add and rearrange commands on built-in ribbon tabs; 

create new tabs and commands.

■■ Quick Access Toolbar  Add and remove command buttons for the Quick Access 
Toolbar.

SEE ALSO  For more information about customizing the Quick Access Toolbar, 
see Appendix A, “Look behind the curtain.”

■■ Add-ins  View, add, and delete Visio add-ins.

■■ Trust Center  View and edit macro settings and other trust-related options.

To display the Backstage view

1.	 Click the File tab.

Understand tool tabs and add-in tabs
Most tabs on the Visio ribbon are visible 100 percent of the time. However, two types 
of tabs appear only when necessary.

SEE ALSO  For information about the Developer tab, which might not be visible in your 
copy of Visio, see Appendix A, “Look behind the curtain.”

Use tool tabs
A tool tab group appears only in a particular drawing context, usually when a specific 
type of shape is selected on the drawing page. Tool tab groups usually appear to the 
right of the View tab and are not always activated automatically when they appear; 
that is, you might need to click the tab to view its contents. A tool tab group includes 
a colored header and might contain one or more tool tabs under the header.

For example, the Picture Tools tab group, shown in Figure 1-21, appears whenever you 
insert or select a graphic on a Visio drawing page. The green Picture Tools tab con-
tains a Format tool tab that includes buttons to crop, rotate, and otherwise modify a 
picture.

Understand tool tabs and add-in tabs
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Figure 1-21  You can use the Format tool tab in the Picture Tools tab group to edit images

Another example, the Container Tools tab group, shown in Figure 1-22, appears 
whenever you insert or select a Visio container. The orange Container Tools tab group 
contains a Format tool tab, which includes buttons to size and style containers, and to 
control container membership.

Figure 1-22  You can use the Format tool tab in the Container Tools tab group to customize containers

SEE ALSO  For more information about containers, see Chapter 13, “Add structure to 
your diagrams.” 

Use add-in tabs
Add-in tabs are associated with software that adds capabilities to Visio. Some add-
ins are packaged with Visio by Microsoft, and others are sold by third-party software 
vendors.

Unlike tool tabs, add-in tabs look and behave exactly like permanent Visio tabs, with 
one exception: they appear when an add-in application is active and disappear when 
it is not.

For example, the Org Chart add-in is included with Visio and is activated whenever 
you create or edit a drawing that uses either of the Visio organization chart templates. 
The Org Chart add-in tab is shown in Figure 1-23.

Figure 1-23  You can change the look and layout of an organization chart by using the options on the Org 
Chart tab
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1SEE ALSO  For more information about organization charts, see Chapter 5, “Create 
organization charts.” 

An example of a third-party add-in is TaskMap, which provides easy-to-use process 
mapping, analysis, and improvement functions. TaskMap can be used with either Visio 
Standard or Visio Professional. The TaskMap add-in tab is shown in Figure 1-24.

Figure 1-24  The TaskMap add-in tab includes functions that integrate Visio with Microsoft Excel, Project, 
and PowerPoint

SEE ALSO  For more information about the TaskMap add-in, go to www.taskmap.com. 

Begin quickly by using starter diagrams
Visio templates have always included stencils full of shapes that you can use to build 
a new diagram. However, even when you use a template to create a diagram, the new 
drawing page is blank and it can be difficult to know how to begin.

Visio 2016 significantly reduces the challenge by providing several dozen starter dia-
grams, each of which includes a properly arranged and formatted set of shapes along 
with a set of tips.

Figure 1-25 shows an example of the starter diagrams that are provided with the 
Timeline template in the Schedule template group. You can click any of the starter 
diagram thumbnails to read a description of that sample diagram and the circum-
stances in which it might be useful.

In all cases, the blank page option is still available by selecting the thumbnail in the 
upper-left corner.

Begin quickly by using starter diagrams
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Figure 1-25  Starter diagram thumbnails provide an accurate preview of diagram content

Selecting one of the thumbnails opens a one-page document that includes the starter 
diagram. Figure 1-26 shows the Expanded Block Timeline diagram.

Figure 1-26  The first page of the Expanded Block Timeline starter diagram
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In addition to the diagram itself, every starter diagram includes a tip pane that con-
tains both general and domain-specific tips. When you are finished using the tips 
pane, you can delete it from the page.

Starter diagrams are available for these Visio Standard templates:

■■ Audit diagram

■■ Basic Flowchart

■■ Basic Network Diagram

■■ Cross-Functional Flowchart

■■ Gantt Chart

■■ Organization Chart Wizard

■■ Timeline

■■ Work Flow Diagram

In addition to those templates, the Professional edition of Visio includes starter draw-
ings in these templates:

■■ BPMN Diagram

■■ Detailed Network Diagram

■■ Microsoft SharePoint 2016 Workflow

■■ UML Class

■■ UML Sequence

■■ UML Use Case

■■ Value Stream Map

To use a starter diagram

1.	 Click the thumbnail for any template.

2.	 In the template information panel, do either of the following:

●● Double-click the thumbnail of the starter diagram you want.

●● Click the thumbnail for the starter diagram you want, and then click the 
Create button.

Begin quickly by using starter diagrams
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To remove the tips pane from a starter diagram

1.	 Do either of the following:

●● Click anywhere inside the tips pane, and then press the Delete key.

●● Right-click the tips pane, and then click Cut.

Explore the drawing window
When you open a document in Visio, two windows normally appear below the ribbon, 
as shown in Figure 1-27.

Figure 1-27  A typical view of Visio includes the ribbon, the Shapes window, and the drawing window

The Shapes window contains one or more stencils, each represented by a header bar 
containing the name of the stencil. Depending on the number of open stencils in the 
Shapes window, a scroll bar might appear at the right of the headers when you move 
the pointer into the Shapes window. You will investigate the Shapes window in the 
next topic.
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1TIP  The width of the Shapes window is adjustable. Consequently, the Shapes windows 
on your computer might be narrower or wider than those that appear in this book.

The larger window on the right is called the drawing window because it contains the 
drawing page. The drawing window is bounded on the top and left by rulers that 
display inches, millimeters, or whatever units you’ve selected (or your template has 
selected) for measuring page dimensions. The gray area between the drawing page 
and the rulers is referred to as the canvas; shapes on the canvas are visible in the 
drawing window but do not print.

TIP  All versions of Visio prior to Visio 2013 displayed an alignment grid on the drawing 
page by default. In Visio 2016, the opposite is true. To make the grid visible, select the 

Grid check box in the Show group on the View tab.

At the lower left of the drawing window is a set of page controls, as shown in Figure 1-28.

Figure 1-28  Page controls are located at the bottom of the drawing window

These controls provide the following functions:

■■ Page Name tabs  These display the name of each page; the name of the active 
page is displayed in a different color. Click any tab to switch to that page. Right-
click any page name tab to access page management functions, including the 
Duplicate Page function.

■■ All Pages button  Click this button to display a list of all pages in the diagram. 
The name of the active page is highlighted in the list.

■■ Insert Page (+) button  Click this button to add a new page.

Below the Shapes and drawing windows is a status bar that contains a variety of indi-
cators, buttons, and controls. The buttons and indicators on the left end of the status 
bar are context sensitive, so they show different information depending on the state 
of the drawing.

Explore the drawing window
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If nothing is selected on the drawing page, the left end of the status bar looks like the 
image shown in Figure 1-29.

Figure 1-29  The left end of the Visio status bar when no shape is selected

These areas of the status bar provide the following functions:

■■ Page Number  This shows which page is active and displays the total number of 
pages in the current drawing. Click this button to open the Page dialog box.

■■ Language  This area displays the language of the current drawing. The drawing 
language is normally derived from Windows or Visio language settings.

■■ Macros  Click this button to start the macro recorder.

If you have selected a shape on the drawing page, the left end of the status bar 
appears as shown in Figure 1-30.

Figure 1-30  The left end of the Visio status bar when a shape is selected

The Width and Height buttons display the dimensions of the selected shape. The 
Angle button displays its angle of rotation. Clicking any of these three buttons opens 
the Size & Position window.

SEE ALSO  For information about using the Size & Position window, see Chapter 3, 
“Manage text, shapes, and pages.”

The right end of the status bar, shown in Figure 1-31, contains buttons and controls 
that affect the view of your diagram.

Figure 1-31  Zoom and window control functions are located on the status bar

■■ Presentation Mode button  Click this to view the active diagram in full-screen 
presentation mode.

■■ Zoom slider  Move this to zoom in or out.
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■■ Zoom Level button  This displays the current zoom percentage. Click it to open 

the Zoom dialog box.

■■ Fit Page To Current Window button  Click this to resize the drawing page so 
the entire page is visible in the drawing window.

■■ Switch Windows button  Click this to switch to another Visio window.

TIP  Most Office applications require the use of a button on the View tab of the 
ribbon to switch among multiple open windows. The Visio development team 

had the foresight to include the Switch Windows button on the status bar where it is 
much more convenient.

If you right-click anywhere in the status bar, the Customize Status Bar menu appears. 
You can use this menu to turn on or off the display of any of the buttons and controls 
on the status bar.

To view a list of all pages in a diagram

1.	 Do either of the following:

●● To the right of the last visible page name tab, click the All Pages button.

●● At the left end of the status bar, click the Page Number button.

To view a different page

1.	 Do either of the following:

●● Click the page name tab for the page you want.

●● Open the list of all pages, and then select the name of the page you want.

To switch windows

1.	 Do either of the following:

●● On the right end of the status bar, click the Switch Windows button.

●● On the View tab, in the Window group, click the Switch Windows button, 
and then click the name of the window you want.

Explore the drawing window

31



How do I scroll through page name tabs?
Versions of Visio prior to Visio 2013 included four page navigation buttons 
in the lower-left corner of the drawing window that you could use to scroll 
through the pages in your diagram. Two of the buttons scrolled page name 
tabs left and right, and two jumped to the first or last page. The navigation 
buttons were especially helpful when the number of pages or the length of 
the page names meant that some page names were not visible.

Although those controls are not present in Visio 2016, there is an invisible 
button that you can use to scroll pages from left to right—to use it, click in 
the space immediately to the left of the first visible page name tab. You can 
scroll pages in the opposite direction by clicking the right-most visible page 
name tab.

Unfortunately, there are no buttons you can use to jump to the first or last 
page with a single click. However, you can jump to any specific page, whether 
or not its name tab is visible, by using the techniques described in the proce-
dures at the end of the preceding topic. As an example, clicking the All Pages 
button results in a clickable list of page names, as shown in Figure 1-32.

Figure 1-32  The color of the current page name is different from all other page names

Two keyboard shortcuts are very helpful for moving from page to page:

■■ Ctrl+Page Down  Move one page to the right.

■■ Ctrl+Page Up  Move one page to the left.
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1Manage the Shapes window
The upper part of the Shapes window contains the title bars of all open stencils, and 
the lower part displays the shapes from the currently selected stencil, as shown in 
Figure 1-27 in the preceding topic. You can switch to any open stencil by clicking its 
title bar.  When you click the title bar of any stencil, the title bars remain stationary, 
and the stencil always opens in the same place, below all title bars. This is a significant 
improvement in behavior over versions of Visio prior to Visio 2010. 

By default, the Shapes window is docked to the left of the drawing window, and it 
usually displays one or two columns of masters. However, you might find that you 
want to adjust or reposition the Shapes window, depending on the diagram you are 
creating or editing.

You can minimize or expand the Shapes window by using arrow buttons. The mini-
mize button is shown on the left in Figure 1-33, and the expand button is shown in the 
image on the right. The minimized view of the Shapes window is most useful when 
the icons depicting the masters in the stencil are easily recognizable.

Figure 1-33  You can view as little or as much of the Shapes window as you want

Manage the Shapes window
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You can undock and float the Shapes window at any time if you would like it to be 
in a different position within the main Visio window. You can also close the Shapes 
window entirely, as shown in Figure 1-34.

Figure 1-34  The Shapes window has been hidden

You can adjust the width of the Shapes window one column at a time by dragging the 
right edge of the window. However, it’s not as easy to locate the right edge as it used 
to be. A user interface change introduced in Visio 2013 causes window edges to fade 
into the background so they don't interfere visually with the content of the drawing. 
Consequently, when the Shapes window is docked on the left, the right edge is not 
visible unless the pointer is positioned directly above it.

Making the boundary visible typically requires moving the pointer slowly across the 
right side of the window until the pointer changes to a window resize tool. The resize 
tool is visible in the image on the left in Figure 1-33.

This same user interface change means that scroll bars in smaller windows only 
appear when the pointer is inside the window. This creates a challenge in the Shapes 
window because you can’t determine whether additional masters are below the 
bottom edge of the window without pointing to the window. In the image on the left 
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in Figure 1-35, for example, you can’t tell that there are additional furniture shapes 
available. The scroll bar makes their presence known when the pointer is inside the 
window, as shown in the image on the right.

Figure 1-35  The pointer must be inside a window for scroll bars to appear

You are not restricted to working with the default set of stencils that opens in any par-
ticular template. You can open one or more additional stencils at any time, as shown 
in Figure 1-36.

Figure 1-36  Cascading menus offer access to all Visio stencils

Manage the Shapes window
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To minimize the Shapes window

1.	 Click the Minimize the Shapes Window button.

To expand the Shapes window

1.	 Click the Expand the Shapes Window button.

To adjust the width of the Shapes window

1.	 Move the pointer in the right side of the Shapes window until it changes to a 
window resize tool.

2.	 Drag the window edge to the left or right.

To undock the Shapes window

1.	 Drag the header of the window onto the drawing page.

To dock the Shapes window

1.	 Drag the header of the window to one of the four edges of the main Visio 
window.

To open or close the Shapes window

1.	 On the View tab, in the Show group, click the Task Panes button, and then click 
Shapes.

TIP  The various subwindows that can be opened or closed within the main Visio 
window are sometimes referred to as task panes. 

To open additional stencils

1.	 In the Shapes window, click More Shapes.

2.	 In the list of template category names, point to the name of the template you want.

3.	 In the list of stencil names, click the name of the stencil you want.

TIP  The stencil opens in the Shape window as soon as you click its name.  
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4.	 (Optional) Click additional stencil names, within either the same template cat-

egory or a different one.

5.	 Click anywhere outside the template and stencil lists to close the cascading 
menus.

Pan and zoom in the drawing window
As you work with Visio diagrams, you frequently need to zoom in and out and 
pan—move left-right and up-down—within the drawing window. Both can be 
accomplished by using a variety of techniques, some that rely on your mouse, some 
that use a special Pan & Zoom window, and others that entail keyboard shortcuts.

The pan and zoom examples in this topic all use the furniture diagram shown in 
Figure 1-37.

Figure 1-37  Four furniture shapes in a full-page view

One of the fastest techniques to view exactly the part of the page you want involves 
drawing a bounding box while holding down the Ctrl and Shift keys. While you draw 
the bounding box, Visio displays what’s shown in Figure 1-38.

Pan and zoom in the drawing window
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